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Diamant-Film DustBuster+

Introduction

Introduction

DustBuster+ is an interactive
tool for repair and retouch of
movie sequences and films.

The product supports automatic
pre-cleaning as well as inter-
active repair. DustBuster+ fully
covers the functionality of the
earlier DustBuster and M.I.R.
products, but extends it far
beyond by introducing a time-
line for automatic filters.
Providing those functions in an
optimised way and working in a
full meta-data mode, makes
DustBuster+ the most efficient
tool in the DI workflow and in
all QC processes for restoration
and wire-removal.

DustBuster+ can work on:

*+ Numbered single file
images that are stored in
one directory;

*  Quicktime/AVI movies;

© All rights reserved: HS-ART Digital Service GmbH, Graz-Austria

« as plug-in (e.g.: DVS
Clipster, ASSIMILATE
SCRATCH);

DustBuster+ is available as free
demo version with full function-
ality, but it does not include any
possibility to save and re-use
the work.

We encourage evaluating Dust-
Buster+ with the demo version
(www.hs-art.com/html/download.html)
and consequently deciding upon
licensing.

As the demo version can not
use file-caching its performance
might be limited compared to
the licensed version. Please
consider this fact in your
evaluation session.

Any further inquiry should be
sent to support@hs-art.com,
where we will give you best
support and answers on any
issue.
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Diamant-Film DustBuster+

Introduction

Installation &
Requirements

As DustBuster+ is based on
precise optical flow motion
estimation your workstation
needs to support cuda 1.3. This
is normally the case if you use
one of the following graphic-
cards with updated drivers:
« NVIDIA Quadro FX 3800 or
more
* NVIDIA GeForce GTX 260,
1GB or more
Additionally required is at least
4GB RAM and a performant CPU
(e.g.: INTEL Xeon multi-core
processors).

Currently the supported
operating system is Windows
XP/Vista/7/2008 in both, 32
and 64 bit versions.

© All rights reserved: HS-ART Digital Service GmbH, Graz-Austria

The distribution of DustBuster+
includes an USB Dongle if
properly licensed!

Log-into Windows as user with
Administrator-rights and start:
Setup_DustBuster+.exe

+ Setup leads you through
the installation process.

* You need to explicitly ac-
cept the licence agreement
to continue.

« We strongly recommend
keeping the proposed in-
stallation directory as this
simplifies support.

« In the course of the in-
stallation the hardware of
the workstation is checked.
You get some message
and bypass proposals in
such case.

Be aware that this may
affect performance!
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3 Quick Start
DIAMAMNT-Film DustBuster+ X5d

Testing your workstation 4 DIAMANT-Film DustBuster+ X64
B Dongle Information

) DustBuster+_¥A4 Manual

|| DustBuster+_X&4 on the Web

L Open Tutorial in DustBuster+_X64
] Release Notes

Remote Support from H5-ART
B Show CUDA DeviceQuery

DustBuster+ makes use of the
GPU processing capabilities as
they are offered in cuda 1.3.

Mostly it will be sufficient to
update the graphic-card driver.
Make sure that any driver used
on your system is not older

than 1.7.2010! L Uninstall DustBuster+_Xa4

After  successful installation Inside DustBuster+ play the

please load the tutorial sequence by pressing the

sequence, that comes along <Space> bar.

with the DustBuster+ instal- In case of unsatisfying

lation. Open it directly when performance, please use the

prompted after installation. "Performance  Tests” option

Alternatively, load it from the from the “Help” menu and let

Windows Start menu by: us know the results.

->Start

->Application Please contact us immediately

->DustBuster+ (support@hs-art.com), if the

-> Open Tutorial in DustBuster+ performance issues are still
pertaining.
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Menu bar Tool & Filter bar Display canvas Tool & Filter parameters

DIAMANT-rim v %

v  Parameters

>

Tool Track
+ Dust

Rend ck DFlicker

Info T Sourc s Output ‘A"
1]

Viewing toolbar Navigation Timeline Frame Number /
toolbar Timecode
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Quick Start

© All rights reserved

Configuration

The configuration dialog can be
opened via the menu Edit=>
Configuration. In this dialog you
can configure the behaviour of
DustBuster+. It is very
important to know that

: HS-ART Digital Service GmbH, Graz-Austria

DustBuster+ has two different
modes of operation which you
can change with the option
"Use Destructive Mode with
backup as default". Default
DustBuster+ is using the non
destructive mode. This means
that the original data are not
changed at all. All changes are
applied and saved to a
subfolder of the original clip.
This means that you need to
Export or Finalize the project at
the end. If the setting "Use
Destructive Mode with backup
as default" is turned on,
DustBuster+  will  work in
destructive mode and
overwrite the original files and
makes a backup of the original
image into a folder next to the
clip. This setting just sets which
mode should be used as default
for the next project which will
be generated. Once a project is
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Quick Start

created, a change of this
setting does not switch the
mode for this project.

Loading

Select Open from File menu and
browse to the location of single
images to be loaded.

Select the sequence and
DustBuster+ will automatically
determine first and last image
to be opened.

Alternatively you can use
Drag&Drop in order to load your
sequence.

Navigation toolbar

Use Space bar to play the
movie, stop by pressing space-
bar again. Navigation can be
done by “<-" or “=>". “Home"
and “End"” are shortcuts to jump
to the first or last image in the
movie.

© All rights reserved: HS-ART Digital Service GmbH, Graz-Austria

For fast cyclic viewing the
operator can use the so called

micro loop for RAM-replay

around the current image. When
stopping the micro loop, the
operator is immediately back to
the same image from where he
started the micro loop.

The playback/render mode
combo-box allows you the
specify the playback behaviour
of DustBuster+. The "Render"

mode will render all
unprocessed tools and filters
while you play. The "Highres"
mode will show you only the
original or processed images in
full quality as available. If there
are preview/proxy images
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Quick Start

available, the "Auto" mode will
show the processed proxies on
fast playback or the highres
images on the still image or
when stepping.
The fps spin-box allows to
modify the playback speed.
Default is the speed as specified
in the header or the
configuration.
By using
“Ctrl+->" or
“Ctrl+<-"
you can
jump  from
one marker
to the next. Default marker for
navigation is “Cuts”. There is
also a predefined marker called
“Black Clips”. Any markers
apart from Cuts, can be
individually defined in the File
menu by selecting Con-
figuration.

Blue Bookmarks

Viewing toolbar

© All rights reserved: HS-ART Digital Service GmbH, Graz-Austria

DustBuster+ permits to switch
dynamically in the display
between sequence A (=result)
and B (=original). You can
simply switch and compare
before-after by using the “Tab”
key.

There are additional controls for
comparison and result

judgement. If you want that,
than you need to select within
the A|B symbol:

By

By Difference Mode  Shift+D

default DustBuster+ shows all
color channels. However, the
operator has full control to
select specific channels for
viewing.

Cirl+Shift+F.
Cirl+Shift+G
Cirl+Shift+8

Cirl+Shift+ A

p.12/63



Diamant-Film DustBuster+

Quick Start

Additional features are the
possibilities to show any mask
or safe-zones, to strengthen
operator efficiency.

One important display function
is the application of look-up
tables. DustBuster+ renders
3D-LUTs on the GPU and is
therefore capable to do that in
real-time.

The predefined LUT can be
turned on/off. The selection of
the look-up-table is done in the
->View Menu

-> Set Lookup Table.

“Esc” is the function to reset all
viewing parameters to their
defaults.

If you want to zoom into
details, then the mouse wheel
can be perfectly used. Just
position the pointer on the
display canvas and apply the

wheel or use the control on the
very right of the viewing bar.

Full Screen Mode

“Shift+F" leads you into the full
screen mode, to maximize the
display canvas.

“Shift+E" provides you with an
exact pixel scale in order to
represent one pixel of the
movie, by one pixel on the
monitor.

Finally “Shift+W" fits the movie
image optimised into the
available display canvas.

Timeline

39% ¥

© All rights reserved: HS-ART Digital Service GmbH, Graz-Austria

The timeline provides an

B

o B[]
& B[] Filter Track
& [=8] Info Track
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Diamant-Film DustBuster+

Quick Start

overview upon the sequence in
use.

The operator can select the
output as A or B, whereas A is
usually the intermediate result
with all operations applied. B is
usually corresponding to the
original source sequence.

Any defined layer is visualised
in a line. Layers might be Tool
Tracks (for interactive tools)
and Filter tracks (for automatic
pre-rendering), but also the
Info Track is visualised as a
separate layer. A track can be
enabled/disabled individually for
A and B by clicking inside the
square. If enabled, the square
is filled with a big dot.

There is always one track
activated at a certain point in
type. Just click on a track to
make a selection. Once
selected, you see in the related
“Tool & Filter bar” the available

© All rights reserved: HS-ART Digital Service GmbH, Graz-Austria

functions for the type of the
selected track.

The render status of the
timeline is visualised as a fine
dark-green line, if all defined
operations and filters are
completely processed. Bright
Green indicates images that are
pre-loaded in the RAM-cache for
performance optimisations.

Red areas indicate those
images that have not been
processed yet.

Any image where there is at
least one operation defined, is
marked in the Tool Track layer.
The currently selected operation
is indicated by a yellow border.
Right-click on the operation
marker, opens a context-menu
with several choices.

New tracks can be added, a
new Cut can be set at the
current position and Delete
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would delete all! operations on
the current image.

The Mouse wheel permits to
zoom in and out in order to
adapt the timeline-view
according to the needs and
actual movie sequence length.

A new track can be added by a
right-click on the timeline head.

Tool & Filter bar

Depending on the track
selection inside the timeline you
can see here a variety of tools
or filters that can be used by
the operator.

© All rights reserved: HS-ART Digital Service GmbH, Graz-Austria p.15/63



Diamant-Film DustBuster+

Quick Start

%

The available tools are grouped
into Paint, Repair, Simple and
Enhance.

The operator can select one of
the tools from the drop-down
menu, but for convenience
there is also a fast access by
function keys. For full de-
scription of the tools go to
chapter 7 of this manual.

© All rights reserved: HS-ART Digital Service GmbH, Graz-Austria

Depending on the selected tool
the operator might either work
in ROI-mode (i.e.: mark rec-
tangle regions) or in brush-
mode (i.e.: to have a brush
with different size and soft-
border).

Brushes can be pre-defined and
stored to make later use of it.
Select the brush, that is
convenient for the purpose. Dy-
namic adaptation of the brush
is available by “Shift+Mouse-
wheel” resp. “Shift+S+Mouse-
wheel” for the softness.

Any used tool has a default
temporal application on one
single image (=current
position).
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A full description of all filters is
given in chapter 8 of this
manual. Just make selection of
your choice and the tool will be
automatically applied on the
current filter-track.

Should this filter track not have
sufficient room, then the
system prompts you in order to

Filter track add another layer.

The available filters are The default temporal duration
displayed in the drop-down of a filter depends on the filter-
menu if you have a filter-track type. However, in most cases it
selected. will be the full length. You can

then manually change the
duration of a tool in the time-
line (use the pointer and select
begin or end of the filter to
change it) or you can enter the
start- and end-position in the
Tool &  Filter parameters
section!

© All rights reserved: HS-ART Digital Service GmbH, Graz-Austria p.17/63
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Tool & Filter parameters

This section on the very right-
side of the DustBuster+
application provides details
about the currently selected
tool or filter inside your track.
Find a detailed individual
description in the reference-
section. If the “Source
Sequence” is selected, than
there is some information about
the selected source material
displayed. This is convenient in
some cases....

© All rights reserved: HS-ART Digital Service GmbH, Graz-Austria p.18/63



Diamant-Film DustBuster+

Operation Principles

Operation principles

DustBuster+ offers 2 principle
modes.
By default DustBuster+ offers a

tool-track, which holds the
application of various
interactive tools that are
applied to correct and repair

any image in the film sequence.
Using “Tool” tracks is the logical
continuation of the former
DustBuster application. The
tools offered can be applied on
single images or parts, marked
by either a brush or a rectangle
region (=ROI).

“Filter” tracks is the mode
for automated application
of filters for pre-cleaning or
other functions. It is an
additional function that
goes beyond what has been
available in DustBuster.
These “Filter” tracks justify

© All rights reserved: HS-ART Digital Service G

the PLUS in the name of

DustBuster+.

Tools

[wsk

Paint Tools

Clane

Faink
Repair Tools

[zt

Interpolate

InPaink

Repair
Enhance Tools

Zalar F2

mbH, Graz-Austria

The tools, that are available to
be applied in the tool track are

grouped into “Paint Tools”,
“Repair Tools” and “Enhance
Tools".

Select the tool of your

preference or use a function
key “F1"” to “F9” in order to
make a quick-select.

The selected tool will appear in
the main window, in the
following sample it is the
“Dust” tool.

Once a tool is selected you
can straight forward apply
it on the current image.

However it might be good
to know, that any tool can
be principally applied by
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Operation Principles

marking a region (ROI) or by
applying a brush.

Depending on the tool, there
might be limitations.

For example, the mentioned
“Dust” tool only supports
rectangle regions, that are
marked in the
region where
dust, dirt and
spots should
be  detected
and corrected.

But there are other tools that
can only work with brushes
(e.g.: “Clone") or others where
the operator has the choice. An
example for such a tool is
“Interpolate”.

Brushes are defined by their
diameter, a softness value and
roundness. These  settings
should be adjusted before!
application of the tool.

© All rights reserved: HS-ART Digital Service GmbH, Graz-Austria

Tracks and Filters

In order to use filters inside
DustBuster+ the concept of
tracks needs to be briefly
understood.

B B Filter Track
& [=[s] |nfo Track

The timeline of DustBuster+
offers different tracks that can
be of type “Tool” or “Filter”.

By default the Tool Track is
enabled, but just clicking on the
Filter Track enables filters and
then you can select from the list
of offered tools.

In order to honour the name of
DustBuster+ the most
prominent and useful filter is
“Dust”. A selected Filter is put
on the timeline and can be
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Operation Principles

trimmed by start- and end-
points in time.

-Choose a Filker- ¥

o

Filters

Dwisk
Colar

ARRI LimZlog

As any filter is applied on a
time-range its calculation might
take a while. Depending on the
configuration and performance
of your workstation and the
resolution a filter might either
work in real-time or take a few
seconds per image (e.g.: “Dust”
in 4k resolution).

Most filters have run-times from
a few milliseconds up to max.
2-3 seconds per image.

© All rights reserved: HS-ART Digital Service GmbH, Graz-Austria

Rendering

DustBuster+ is doing its best to
give immediate operator
feedback about all applied
actions. However, some (as
e.g.: dust filter over full time-
line) might take too long. Thus
there is an intrinsic rendering
applied automatically to show
the image at the current
position. So if you run a “play”
on your sequence, everything
will be rendered once the “play”
is completed.

Sometimes  this  automatic
rendering when playing is not
what you want. Therefore you
can turn this off by selecting
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Meta-Data mode

DustBuster+ is working in a
meta-data mode, thus all
definitions, actions and settings
done by the operator are
recorded and can be re-applied
at any later stage (even on
different image sequences resp.
resolutions).

On the other hand this means
that all operations that are
finished are not stored
automatically in the file-system.
However DustBuster+  uses
RAM and hard-disk for caching,
in order to avoid expensive re-
calculation.

Consequently, in the end of
operator interaction, an export
needs to be done.

"Preview" or "Highres" from the
play back behaviour combo-box
located in the navigation tool
bar at the bottom

If you select "Render" the
rendering while playing s
turned on.

For convenience we also offer a
Render-menu inside Dust-
Buster+, that is more powerful
and efficient.
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Diamant-Film DustBuster+ Operation Principles

This step is invoked by using [ —c—
the menu entry ->File B AEEEm—
-> Export. (’.\ Finalize

|
In the export dialog you select k!J :

a location, file format, etc. and
start the export to create the
permanent files.

Alternatively you can call the
Finalize function. Finalize will
replace the original images with
the rendered images from your
work. Please note that
DustBuster+ makes a backup of
the original data and the
metadata by default. This
function is only available in the
non-destructive mode.

Please note that this function is
very important if you should
use DustBuster+ as plug-in,
using are in the non-destructive
mode, in other Applications like
DVS Clipster or ASSIMILATE
Scratch.
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Diamant-Film DustBuster

Step-by-step Tutorial

Step-by-step |
Tutorial V

Consult also our video tutorial
to learn efficient wuse of
DustBuster+.

Introduction

DustBuster+ marks the next
generation of digital film
cleaning solutions. The
interactive tools and the fully
automatic REPAIR filters allows
efficient cleaning with
convenient operator interaction.

An integrated interactive quality
control environment ensures
the best possible results for
your restoration projects. Split
screens, difference masks and
toggling between before&after
is standard. It is easy to undo

© All rights reserved: HS-ART Digital Service GmbH, Graz-Austria

something or to fix something
which has been missed.

DB+ is supporting many
professional file formats such as
DPX, CIN, TIFF, JPEG2000 and
many more in all their
variations of 8bit, 10bit, 16bit,
LIN/LOG and monochrome.

DB+ does have full metadata
support, meaning that
everything you do is recorded
as metadata and the original
images are never touched. With
almost unlimited undo's you
don't have to worry to make
any mistakes.

GPU based rendering is included
to give you the highest quality
with the best performance

Our new playback engine gives
you the best possible playback
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from your local drive,
network drives and
SAN. With integrated

%) DIAMANT-Film

caching and micro -7 DustBuster+
loops you can benefit Recent Pract
from real-time

playback even on
slower disk drives or
connections.

DB+ is available on
Windows and Mac.
Please refer to our

system
recommendations for E—
further details. From the File menu: Open, and
navigate to the destination
Opening a Image where the files are_ located _
Sequence or Project Open a recent project from File-
>Recent Sequences
There are several ways to open Drag&Drop an image from a
a sequence or project. sequence onto the DB+
From the DB+ welcome screen Open last project tool button

Open Sequence
Open a Recent Project
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Diamant-Film DustBuster

Step-by-step Tutorial

In our case we want to open
the Tutorial. The easiest way to
do this is from the welcome
screen and choose Open
Tutorial. Alternatively you can
use the windows start menu
and select "Open Tutorial in
DustBuster+" in the DustBuster
section of the start menu.

After opening the Tutorial you
should see the loaded clip.

© All rights reserved: HS-ART Digital Service GmbH, Graz-Austria

Playback & Navigation

To start playing you can hit the
Space bar or press the play
button on the right side of the
navigation bar. If you hit Space
again the playback will pause.

You can control the

playback speed
with the fps spin box. On the
very right on the navigation bar
you will see the actual play
back speed. This may vary from
the selected play back speed if
your I/O system can not deliver
the frames fast enough.

Next to it you can see the
actual frame number
/timecode. You can change this
to display timecodes instead by
MouseRightClick on it. It is also
possible to modify the frame
number of timecode in order to
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Step-by-step Tutorial

jump to a certain frame or
timecode.

The micro loop play
@ i

mode will circle around
the frame where you have
started this play mode. If you
stop you will be exactly on the
same frame where you have
started. The duration of the
micro loop mode can be
configured in the Configuration
dialog from the File menu.

H The loop mode

changes between
ping-pong and loop playback of
the sequence

The bounce mode
: changes the
behaviour on the cuts. If it

should bounce back on the cuts
or play over the cuts.

© All rights reserved: HS-ART Digital Service GmbH, Graz-Austria

The playback /
render mode

combo-box
allows you the
specify the

playback behaviour of
DustBuster+. The "Render"
mode will render all

unprocessed tools and filters
while you play. The "Highres"
mode will show you only the
original or processed images in
full quality as available. If there
are preview/proxy images
available, the "Preview" mode
will show the processed proxies
as available.

. It is also possible to
grab the triangular
handle with the LeftMouse and

drag the indicator to any
position in the timeline.
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Step-by-step Tutorial

And last but not least you can
navigate through your sequence
be using the arrow keys KeyLeft
and KeyRight to go to the
previous and next frame. With
PgUp and PgDown vyou can
jump from cut to cut if the cut
markers are present. Home and
End will bring you to the
beginning and end of the
sequence.

Viewing Basics

The viewing toolbar is located

below the player widget. On the
very right you see the actual
zooming factor. You can click on
that and a little slider will
appear where you can change
the zoom factor. But the better
way to zoom is to use the
MouseWheel. Position the
mouse curser where you would

(T
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like to zoom in/out and use the
MouseWheel to apply the zoom.

The next button from the right
will fit the image to the window
size. The 1:1 button show you
the image in the exact pixel
scale.

The pan tool from the top
toolbar  will change the

interaction mode into pan. If
this mode is activated, you can
the LeftMouse to pan the

image. Better is to use
Shift+LeftMouse for panning
since this does not require to
change the interaction mode
and is always possible.

Esc will reset your display to
default which is a quick way to
get out of zoom and pan.
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Step-by-step Tutorial

It is possible to view the
cannels individually. Default
you will always see all channels
but sometimes it could make
sense to look at a specific
channel.

In a later section we will talk in
more detail about the other
viewing options ins
DustBuster+.

The Timeline

The timeline consist of layers
and the layers contain tracks.
Per default you will have a
Source Sequence track
representing your image
sequence, a filter track and a

Source

© All rights reserved: HS-ART Digital Service GmbH, Graz-Austria

tool track. You can click on the
track to activate the track. An
active track is highlighted in
orange. Depending on if you
have selected a filter track or
tool track you can insert a new
filter or apply a tool. Filters are
normally working over several
frames and a tool is working on
the current frame.

When the tool track is activated
you can choose the tool you
want to work with from the
main toolbar.

If a filter track is activated you

main toolbar. Please note that
the main difference is that the
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Diamant-Film DustBuster Step-by-step Tutorial

filter will be inserted into the ﬁ In the view toolbar there is also

timeline directly and a tool you
have to apply with a brush or
ROI interaction.

B There are two columnes,
Cm| one for A and one for B. In
Ol this case A is activated

indicated by the orange A.
In this column you will see
boxes with a dot in it. This
indicates which layers are
turned on for A or B. Default all
layers are turned on for A and
only the source layer is turned
on for B. Normally A means the
output of all filters and tools
and B means the input.
Typically this is known as
"before" and ‘“after”. It s
possible to toggle the main
display to show either before or
after. To toggle between, you
can press the TAB key.
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a toggle button for this and it
will also show you if A or B is
active.
As long as there is no tool of
filkter you will see the same
image.

Using the Dust Tool

The Dust tool can be used for
many different types of single
frame defects like dust, dirt,
scratches. This tutorial will
show you how to use the tool to
fix this kind of defects.

Please open the tutorial
sequence as described in the
"Opening a Image Sequence or
Project" tutorial.

Navigate to frame 99327
You will see some dust spots on
his left arm.
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Alternatively you can press also
the shortcut for this tool (F5).

You will see in the combo-box
that dust is selected now. As
interaction dust uses per
default rectangular ROIs. This is
selected by default also. Other
tools may have other
interactions possibilities like a

brush.
Enhance
The simplest way to remove
. now the dust spot is to draw a
Make sure that the Tool Track is ROI around the brush.
active which you can see that
text highlighted in orange text m

color.

Click on the tool selection
combo-box on the main toolbar.
This will open a pup-up menu
from where you can choose the
tool you want to use next.
Select Dust.

The ROI will be
highlighted in red as
long as the render process is
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active and will disappear
thereafter. As final result you
should see the image without

the spot. Please not that you
don't need to select the dust
spot very accurate since Dust
will detect the spot inside the
ROI and just replace the
detected spot.
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On the right side of the
DustBsuter+ you can see the
parameters to the selected tool.
In this case the Dust tool.

You can change the parameters
even after you have drawn the
ROI. The last parameters you
have selected will be used also
for the next dust spots.

On the first ROI you draw on an
image the motion will be
calculated automatically in the
background, so the first ROI
might take a little longer.
Following ROIs on that frame
will be rendered faster since the
motion  estimation is not
necessary any more.

You can draw as many ROIs
and as fast as you want on an
image. The requests will be
queued and rendered one after
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the other. Everything is finished
once the red boxes have
disappeard.

Reference

Indicates which frames Dust
should use as reference for
detection and fixing. Auto is
choosing the reference
automatically and works also
correct on shot boundaries. Left
only would only use the
information from the previous
frames and right only from the
next frames. Double spot will
use the previous frame and the
next + one.

Sensitivity

This  value indicates  the
detection sensitivity. The higher
the value is the more will be
detected as dust. If the value is
too high, false detections will
increase.
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Min size(px)

The minimum size of the spot
that is detected as spot. If the
value is too small, Dust might
detect grain as a spot.

Hint:
The shortcuts for the
parameters are shown in the
parameter widget. For example
means press key 1 to
activate this parameter. The
symbol means that you
can change this parameter by
holding down the G key and
using the mouse wheel to
increase/decrease the value.

In order to clean up this frame
you just need to draw ROIs
around all dust spots you see.
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On the timeline you will see an
indicator showing that there are
operations on this frame.

This section was showing you
how to use the Dust tool to fix
dust and dirt spots.

Using the Interpolate

Tool

In contrast to the Dust tool,
Interpolate does not try to
detect a defect, but will replace

the marked content with
information from the
neighbouring frames.

You can mark the
area which you
want to interpolate
either with a
rectangular ROI or
you can use the
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brush to paint a mask which
should be replaced by the
interpolate.

Please open the tutorial
sequence as described in the
"Opening a Image Sequence or
Project" tutorial.

Navigate to frame 99332
You will see some spots next to
his right arm

Draw a rectangular around it
and the Interpolate  will
automatically replace the area.

As you can see it will not fit in

p.34/63



Diamant-Film DustBuster

Step-by-step Tutorial

perfectly in this case.
The reason for this is that this

example contains very
complicated
non-linear
motion.
Therefore we
have an
option to
move the

interpolated area afterwards to
fit it in perfectly.
This is done with the spatial
offset parameter.

In this case use +3 for the
horizontal offset and -3 for the
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vertical offset.
This will fit in
the patch very
nicely.

In the most
cases this will
not necessary.

The Blending with parameter
controls how many pixels on
the border of the rect will be
blended with the original
information. This will ensure a
smooth fit of the interpolated
patch into the image.

Please refer to the manual for a
more detail description of the
Interpolate tool.
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Using the Clone Tool

In some cases where
the semi-automatic
tools like Dust and
Interpolate can not be
used it could make
sense to use the Clone
tool. The Clone tool
can be used to
copy/clone
information from an
other position or even
other frame to replace
an area with the
defect.

Please open the
tutorial sequence as
described in the
"Opening a Image
Sequence or Project"
tutorial.

Navigate to frame
99337
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You will see a spots on his

collar right from the
head.

The interaction with the
Clone tool is the brush.
So you paint on the
image wherever you want
to apply the clone. The
most convenient way to
adjust the brush size is to
use Shift+MouseWheel.
This will make the brush
bigger and smaller. With

Shift+S+MouseWheel
you can adjust the
softness of the brush.
Alternatively you can
adjust the brush using
the brush configuration
dialog which will pop-up
when you click on the
brush tool button in the
main tool bar.
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Actually our Clone tool is a 4D
clone because you can change
the clone source spatial (X, Y
offset), temporal (other frame
in time) and you can select a
track/generation (from timeline
stack).

The best way to think about our
Clone tool is that you have the
current image you are working
on in the front (foreground) and
that you have a reference
image where you clone from in
the back (background). When
you apply a brush you are
painting a mask (hole) into the
foreground and at that position
the information from the
reference frame (background)
will shine through.

This allows to modify vyour
reference even after you have
applied the brush stroke.
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Meaning you can change the
parameters like spatial or
temporal offset after the stroke.
If you change the luminance
this will also change the
luminance of the reference
frame and so on.

Ok. Now
select a
reasonable

brush size and
try to paint
out the dust
spot.

And vyou will notice
that the cloned in
information does not fit
in very well.

The reason for that is
that we have a spatial offset of
1 and there is quite an amount
of motion between those two
frames. Now we need to
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compensate this motion by
adjusting the spatial offset.
There are several ways to do
this

Compensate motion:

manually changing the spatial
offset with the spatial offset
parameter widget

hold down the Alt key and pan
the reference image with using
the LeftMouse until the
information is fitting in

using Auto Align
by pressing the
A key. In order
to do so you
need to move
the mouse
pointer to an
edge nearby.
Like where the head and the
collar meet and press A
afterwards. This will try to align
foreground and background
image at that position. Please
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don't use the area where you
have painted since there is the
defect which will cause a fail
function of this option

After
pressing the
A key as
described

you should
get a result
like this and
a X offset of -
8 and a Y
offset of +5.
and the
information
should fit in
nicely.

If you start a new clone
respectively brush stroke a new
clone tool will be applied. The
last used parameters are kept
and when vyou change the
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parameters, only the new clone
operation will be affected.

In order to add a brush stroke
to an existing clone you need to
hold down the keys Ctr/+Alt
and apply the brush with the
LeftMouse as usual. This allows
you to group several brush
strokes into a single operation.
It is also possible to subtract a
brush stroke from the current
painted mask by using the
RightMouse.

Pleas refer to the manual for
further information.
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6 Reference Section

Starting DustBuster+

After installation DustBuster+ is
available directly from the
desktop of your workstation.

It is also available from the
Windows start menu.

File Menu

Open Ctrl+0O
Opens an image sequence or an
existing project. DustBuster+
project files can only be opened
if they have been previously
created by an operator of the
same company. The project
files have the suffix ".m2".

Open Additional Source
You can select a second clip for
comparison or as clone source.
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Open (Recovery Mode)

If the project should crash
repeatedly after normal open
you can open the project in this
mode.

Recent Projects

Provides fast access to the
sequences that have been
recently used as well as to the
recent loaded DustBuster+
projects.

Source Information Ctrl+I
Provides some feedback about

the sequence under treatment
(e.g.: resolution, number of
images and location).

Import Markers from
Pronto/Clipster

This allows you to import
markers from a DVS Clipster
project file
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Import Markers from EDL
This allows you to import
markers from an EDL file. The
markers will be shown as
bookmarks or as shot marker
inside DustBuster+.

Export Markers to EDL

A selected marker type can be
exported into an EDL for further
usage.

Export

Opens an export dialog to
define a target location for the
final sequence. Restored
images that are already
available in file-cache are used,
all other images are re-
rendered.

Finalize
Finalize function. Finalize will
replace the original images with
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the rendered images from your
work. Please note that
DustBuster+ makes a backup of
the original data and the
metadata by default.

Please note that this function is
very important if you should
use DustBuster+ as plug-in in
other Applications like DVS

Clipster or ASSIMILATE
Scratch.
Close Ctrl+W

Closes the project and
sequence, but DustBuster+
remains loaded.

Exit Ctri+Q
Quits the application.

Edit Menu
Undo Ctrl+zZ

Implements an “Undo” on the
previous action.
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Redo Ctrl+Y
Implements a “Redo” on the
previous “Undo” action.

Select All Ctrl+A
Selects all tools that are defined

on the current image for any
further common action (e.g.:
“Delete Operation”).

Delete Del
Deletes the currently selected
operation, tool or filter.

Configuration
Opens a dialog to define some
major settings for DustBuster+.

View Menu

The most important setting A/B Mode

currently available is the Permits toggeling between
possibility to define your own original (B) and repaired (A)
short-cuts. movie sequence.

However, we recommend to use

it carefully, as this might make Split Screen

support and usage by other Permits comparison (side-by-
operators more difficult. side view) of original (B) and

repaired (A) movie sequence.
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Blend Mode
Blends (A) with (B)

Difference Mode Shift+D
Shows the changes done by the
tools and filters in red
highlights. Press TAB for
toggling between difference and

(A).

Show Mask Shift+M
Highlights the areas where tool-
brushes are marked. Press
another time for toggling.

View All Channels  Ctrl+Shift+A
Shows all colour channels.

View Red Channel Ctrl+Shift+R
Shows only the red colour
channel.
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View Green Channel Ctr/+Shift+G
Shows only the green colour
channel.

View Blue Channel Ctr/+Shift+B
Shows only the blue colour
channel.

Set Lookup Table

Opens the LUT dialog for
configuration and selection of
LUTs.

Fit to Window Shift+W
Fits the image into the window.

Exact Pixel Scale (100%) Shift+E
Sets the zoom factor to 100%.

Full Screen Shift+F
Switch to full screen mode.
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newly added track is the same
than the track of the previously
Previous Frame Left selected.

Goto to previous image.

Navigation Menu

New Tool Track
Next Frame Right Adds a new tool track on top of
Goto to next image. the current track.

New Filter Track
Adds a new filter track on top of
the current track.

Rename Track
Renames the track

GotoGoto First Frame Home
Goto to first image in sequence. Delete Track

Deletes the currently selected
Goto Last Frame End track and all operations defined
Goto to last image of sequence. on it!

Tracks Menu Marker Menu

New Track Ctrl+T Goto Previous Marker  Ctri+Left
Adds a new track on top of the Goto to the previous marker.

current track. The type of the
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Markers Help

Goto Next
Marker

Goto to the next
marker.

Goto Previous
Cut Marker PgUp
Jumps to the beginning of cut

Goto Next Cut Marker PgDown
Jumps to the beginning of next
cut

Toggle Cut Alt+C
Sets the cut marker at the
current position. If a cut marker
is already set at this position it
is unset.

Delete all markers of type
Deletes markers of the type as
selected in the marker selection
combo-box in the navigation
toolbar at the bottom.
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Help Menu

About DustBuster+
Shows the version
number and gives
some background in-
formation about DustBuster+.

Show Shortcuts
Shows a list of available
shortcuts. Any individual
adaptation needs to be done in
the ->Edit Menu
->Configuration.

Performance Tests

Checks the available hardware
with a special focus on
graphics-board and hard-disks.
The result of the test should be
sent to support@hs-art.com for
performance tuning.
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Tools

DustBuster+ supports a number
of integrated tools for
interactive use. The following
section provides a detailed
description on the tools and
their functions.

Dust Tool

The tool that is most
frequently used in
DustBuster+ is the
Dust Tool. In order
to use it, the
operator must have
a Tool Track Layer
enabled.

Dust uses rectangle
regions as
interaction with the
operator. Thus the
operator needs to
mark an area, where
then Dust is
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detected and corrected auto-
matically and on the fly.

The operation of the Dust Tool
can be controlled by
parameters. Adaptation of
parameters results in a re-
application of the currently sel-
ected operation and influences
also all further operations.

In most cases the
default parameters
should be sufficient,
however for various film
materials and
characteristics it might
be necessary to slightly
vary them.

After an operation
(=rectangle ROI) is
initiated, the calculation
is automatically done.
The first operation on
an image might
consume up to 0.5
seconds, all further
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operations are calculated
without significant loss in time.
Reference

Indicates which frames Dust
should use as reference for
detection and fixing. Auto is

choosing the reference
automatically and works also
correct on shot

boundaries. Left only
would only use the
information from the
previous frames and
right only from the next
frames. Double spot will
use the previous frame
and the next + one.
Sensitivity

This value indicates the
detection sensitivity.
The higher the value is
the more  will be
detected as dust. If the
value is too high, false
detections will increase.

> Advanced
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Min size(px)

The minimum size of the spot
that is detected as spot. If the
value is too small, Dust might
detect grain as a spot.

Interpolate Tool

The Interpolate Tool is an
alternative to the Dust
Tool. It uses adjacent
images to correct

the area, that has been
marked by the
operator. The operator
can choose between
rectangle ROI or a
brush. For normal
operations we
recommend to use
brushes as border
problems and other
eventual unwanted
effects are avoided.

The  tool can be
controlled by some
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parameters, any variation of
the default parameters results
in re-calculation.

Use “F6” as quick-select for the
tool.

Reference

This works very similar as the
reference in the Dust Tool.

Spatial Offset

In some cases when the motion
is non linear the interpolated
area may not fit in perfectly. In
this cases you can move the
interpolated region after the
interpolation for better fitting.
Blending width

If you are using rectangular
ROIs for the interpolation this
indicates how many pixels on
the border of the interpolated
region should be blended with
the original content.

Additional sharpen
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This hides the effect that
interpolation is slightly
removing the grain structure.
Regraining

If you have very grainy material
you might want to add grain to
the interpolated region to
compensate the grain which
was lost during interpolation.
The grain structure is
automatically analyzed from the
frame.

Regrain magnitude

With this parameter you can
control the amount of grain
which will be added

InPaint Tool

If the adjacent images do not
contain any relevant infor-
mation to repair a specific film
defect, than the operator
should use InPaint. This tool is
specifically useful on permanent
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defects such as dead-pixels or
vertical line-scratches.

The tool works only on areas
marked by brush and should be
very carefully adopted, as its
correction function is limited,
especially on large areas.

Use “F7” as quick-select.

ExInPaint Tool

This is an automatic content
aware in-painting tool. It is
working like an auto healing
brush but in a very
sophisticated way. It does need
GPU/CUDA in order to work and
can get slow on bigger regions.

Repair Tool

If there are some low-contrast
stains and lightning changes
(very often created by mould),
then the new Repair Tool might
be more applicable. The tool is
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simple and can be used on
areas marked by brush only.
Sensitivity

This controls the detection
sensitivity of the tool. 100% will
put the detection to a maximum
level.

Grain protection

If you have grainy material you
can avoid false detection by
increasing this parameter.
Reference

Specifies the source frame
which  should be wused as
reference for the tool.

Clone Tool
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The tool provides the possibility different input track. In the

for interactive cloning
from any area of the
image sequence. The
operator can use
temporal and spatial
offsets to dynamically
adapt to the situation.
The use of Clone Tool
might be quite ex-
pensive in terms of
operator time spent,
therefore we recom-
mend to use it only as a
last step, if the defect
can not be corrected by
more convenient tools
such as Dust, Inter-
polate or Repair.

Source track

Additional to the spatial
and temporal offset this
allows to change the
clone source to a
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DIAMANT-FILM Restoration
integration this allows also
to choose a (different
generation. Please note
that in the integrated
version you can change the
generations with the film -
role icon from the viewing
menu if the option

Sync to Source 'B'

is turned on. If this option
is turned on than the
source is synced to the
viewing source 'B'
automatically

Spatial Offset
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This controls the spatial offset
of the cloning source from
where information will be
cloned in. You can imagine the
cloning source as an image
sitting behind the image you
are working on. With the brush
you just paint a hole into your
image (mask) and the
information from the frame
behind will shine through. Even
after you have painted the
mask you can change the
spatial offset (move the image
behind). You can change the
spatial offset by using the arrow
buttons on the widget, or you
can click inside this widget and
move the mouse. More
convenient is to use
Alt+LeftMouseButton and move
directly on the image. With
Alt+LeftMouseDoubleClick  you
would select the point were you
click as center of your clone.
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Temporal Offset
Selects the temporal offset for
the cloning reference. 1 means
the next frame, -1 means the
previous frame.

Red, Green, Blue
This can be used for color
balancing

Luminance

This is a manual luminance
correction of the clone
reference frame.

To make it more efficient there
are 2 support functions in-
cluded.

Rotation
You can rotate the clone
reference up to 360°.

Scale

You <can scale the clone
reference

Auto Align

This automatically computes
the horizontal and vertical
offset at the current mouse
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position to match the image
with the cloning reference. Note
that this may fail on the cloning
position because there this is
normally not a good reference
for the auto align. Please move
the mouse to a position in the
image nearby where a good
edge is present to help the
matcher.

Auto Luminance

Automatically corrects the lumi-
nance in order to minimise
differences to the surrounding
areas.

Both support functions depend
on the current mouse-position
when applied, therefore it might
be necessary to use the
function several times to get
best results. In order to apply
Auto Align press the "A” and “B”
for automated brightness cor-
rection.
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Default settings that might be
used several times can be
dynamically stored and re-
applied (=Preset) any time.

The tool is simple and can be
used on areas marked by brush
only.

Use “F1” as shortcut for quick
tool selection.

Paint Tool

This tool is only wused in
exceptional cases and permits
to paint new content. You can
use it with a brush and
individual color-settings.

History Brush

The tools operates in a very
similar way than the previously
explained clone tool. It provides
you with a brush to UNDO any
actions in order to revert to the
original and heal any unwanted
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side-effect. It is manually, Enhance Tools
therefore application of the tool
is costly in terms of operator
effort.

This is a toolbox for some
enhance tools like ColorBalance

ColorBalance

Currently the last tool in the list
is ColorBalance. The tool
permits simple RGB and
luminance adaptation. It can be
used by either rectangle-ROI or
brush.

The tool is not a full color
correction, for this you need to
apply the primary color
correction filter (Primary CC),
that is described in the next
chapter.

Simple Tools

This is a toolbox for standard
filters like Blur, Sharpen and
the like.
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8 Filters

DustBuster+ supports only a
limited number of integrated
filters. The main focus is on
filters for the key competence
of dust and dirt removal and
some general utilities.

The following section provides a
detailed description on those
filters and their functions.

Dust

Filter  for detection and
correction of spots, stains,
hairs, etc. The Dust filter is
good for any kind of film defect ¢| Remove dar
with a unique appearance in

time (=single image defects). igh preasion

The dust module uses a 2 Motion confidence

phase approach. In the 0 v

detection phase the tool looks » Advanced

for spots that are unique in one with defects are marked on
image (temporal view). Areas every frame in a clean plate. In
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the removal phase image But be aware that you will
information is retrieved from detect less spots also.

the motion-compensated Min. size

adjacent images and fit into the This parameter defines the
image to be repaired. The minimum size of dust spots in
repair also respects brightness pixels that can be detected.
variances of the individual Usually it should have a value
images, such that the pasted larger than the grain (if there is
spot is invisible to a very large any) to protect it from mal-
extend. detection.

Sensitivity Max. size (sqpx)

This parameter defines the This parameter determines the
contrast difference between a maximum size of spots to be
detected  spot  and its detected. A typical value of 10
surroundings (the higher the means that the max. size of
value the more spots are corrected spots is 100 pixel
detected!). (10x10 pixels).

Protection: Remove bright spots /dark
This configures the internal spots

safeguard mechanisms. 0 will By checking this option, the
turn off additional means for user can select whether the
avoiding side effects. The dust filter shall detect and
higher the value the more remove bright spots and/or
cautious the algorithm will be. dark spots.

High repair precision:
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To get the best quality you
should turn this feature on.
However if you prefer to work
much faster you should turn it
off. There is a trade off between
speed and quality.

Motion confidence

This specifies the minimum
reliability of the motion
estimation needed to fix a spot.
This is a percentage value
between 0%-100%. 0%
disables the function where
100% means that the motion
estimation needs to be perfect.
This is an additional parameter
to avoid unwanted artefacts
coming from complicated
motion situations. In general a
value between 80% and 90% is
recommended.

Please note that you need to
have CUDA support in order to
use this parameter.
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Motion calculation method: Here
you can select between a GPU
based motion calculation or a CPU
based motion calculation.
Preferable is the GPU based one
since it is faster and delivers a
better quality motion field.
However if you don't have an
adequate graphics card available
you need to select the CPU
fallback.

Remove Spots brighter/darker
than Threshold: The threshold
slider allows to define an absolute
brightness value. Only spots that
are brighter/darker than the
selected threshold will be
removed. If the threshold slider is
set to “0” for bright and “100” for
dark spots, all detected dark
spots (regardless of the absolute
brightness value) will be
removed.

Sometimes it is usefull to restrict
the first value to 70% and the

p.56/63



Diamant-Film DustBuster+

Tools & Filters

second to 100% to make sure
that only spots brighter than 70%
could be found.

= Border protection width/height:
In some cases (over-scanned
material with moving borders),
the dust filter can produce side
effects on the image border,
especially when used with more
aggressive settings. The two
sliders set the area of the image
that will be excluded in % of the
total image width/height and thus
protect the border from the dust
filter.

= Detection method: Default is
Standard. If you select Forced
Mode then some internal
protection mechanisms are turned
off. This leads to a more
aggressive detection with the risk
of higher false repairs.

= Use alpha dust mask: Some
image formats like DPX can carry
additional channels holding mask

information. Dust can use such a
mask as dust mask instead of
detecting the dust mask by itself.

Repair

A new filter that automatically
analyses multiple images (up to 7) in
order to detect light variations and
improper image changes. It could be
used instead of DNoise, as it is able
to preserve the grain properly, but
correct light and low-contrast
imperfections that could not be
handled with any other tool before.

= Sensitivity:

Defines the effect-level of the filter. A
value of “"100” means that maximum
correction is enabled. Any lower
value protects some structures.

= Negative sensitivity:

This is an additional protection-
parameter to reduce side-effects. For
maximum effects the value could be
set to "0”. Any higher values protects
some structures.
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= Grain protection:

The values defines the grain size and
low contrast structures below the
value are not changed. Thus any
grain can be protected, if this is
wanted (usually this is a must for
archival restoration).

= Confidence method:

This parameter should only be used
in cases where there is a difficult
motion and where side-effects need
to be eliminated. As the parameter
strongly reduces the effects applied,
we strongly recommend to start with
a value of “None” and revise it only
when there is need for it.

The  following parameters are
technically more sophisticated and
should only be changed by
experienced operators or after
consulting support@hs-art.com.

=  Number of frames:

Defines the scope of the filter. A
value of "5 frames” means, that the

filter is looking in a neighbourhood of
+/- 2 images beside the current
image. The higher the value, the
stronger is the effect of the filter, but
also the risk of side-effects.

= Protect dark/bright:

This value can be chosen if some
specific dark and light values should
not be changed by the filter. A value
of “20%" would guarantee that all
black below 20% brightness stays
untouched.

= Motion compensation:

Normally the filter should be used
with motion compensation, otherwise
the risk of side-effects is very high.
However, in some cases or regions
(e.g.: back-ground) you could apply
the filter without compensation in
order to achieve a stronger effect.

* Reference:

This defines the location from where
pixels to be corrected are taken. A
value of “Previous” means, that it
would take the neighbouring image,
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that is located before the current
image. A value of “Pixelwise” means
that the filter decides internally pixel.
By pixel, where it will take the
information from. The value “Auto” is
similar, but the source location is
kept constant for all pixels inside the
image. But for another image the
source location might change.

= Enlarge detection:

If the detection of effects to be
corrected is too fine-grained, than
this value might be adapted.
However, this parameter is very
specific and you need to carefully
record any change herein!

ExInpaint

This is an automatic content
aware in-painting tool. It is
working like an auto healing
brush but in a very
sophisticated way. It does need
GPU/CUDA in order to work and
can get slow on bigger regions.

The ExInpaint Filter is the
extension of the ExInpaint Tool
over the time.

Paint with the brush the area
which should be replaced on the
start frame of the filter. You can
use also an animated brush if
the area is slightly moving.

= Keyframe weighting:

This parameter indicates how
important the last solution
(previous frame) is for the
current image. If the value is 0,
every frame will be calculated
individually. If the value is high,

the ExInpaint will use
information over the time to
repair also.
DeadPixel

The filter can remove small
regions of constant defects
appearing in every frame on the
same position. The filter is
using a spatial interpolation
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technique to fill the defect
region with information from
the surrounding. It does
operate only on rectangular
ROIs. The limitation is that the
ROIs should be quite small in
order to get reasonable results.

Transform
The filter supports the
correction in the
geometrical domain. In
difference to all
previously described

filters, the default-
duration of Transform
Filter is one single
image. However, it can
be manually prolonged
and adapted on the
timeline as any other
filter.

Primary CC

The filter provides  basic
functions to support primary
color correction.

Colors can be corrected based
on Shadows, Midtones and
Highlights as it is common
industry standard.

In addition Saturation, Lift,
Gain and Gamma can be
corrected.

Invert

This is a filter to convert
positive into negative material
and vice versa.

Gaussian Blur

This is a standard blur filter.
Sharpen
This is a standard sharpen filter.

HistoryFilter

This filter is quite helpful to
undo certain parts of the image

Highlight Saturation
1,00 4
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over the time. It is using an
animated ROI or animated
Brush. For example if you want
to undo bad fixes from an
automatic dust filter because of
very heavy motion on a certain
part of the image in a scene
you can use this filter to do so.
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9 Shortcuts

DustBuster+ is dedicated for
the operator’s convenience and
efficiency. Thus nearly all
functions can be assigned to
specific keyboard and mouse
interaction. The following table
shows the predefined shortcuts
of DustBuster+. Please note,
that these results from a series
usability studies and will allow
an efficient and consistent
interaction using the mouse
wheel and keyboard shortcuts.

Most of the parameter shortcuts
are directly shown in the
parameter widget. Like the
symbol EE stands for hold
down the "S" key and use the
MouseWheel to modify the
parameter.

© All rights reserved: HS-ART Digital Service GmbH, Graz-Austria p.62/63



Diamant-Film DustBuster+ Shortcuts

Open Ctrl+0 Microloop Ctrl+Space
Quit Ctrl+Q Prev Frame Left|S
Next Frame Right|D
Toggle A/B TAB Prev Microloop Position Alt+>
Show/Hide Mask Shift+M Goto First Frame Home
Difference Mode Shift+D Goto Last Frame End
View All Channels  Ctrl+Shift+A Auto Spatial Offset A
Show Red Channel Ctrl+Shift+R Auto Luminance B
Show Green ChannelCtrl+Shift+G
Show Blue Channel Ctrl+Shift+B Brush Size Shift+wheel
Brush Softness Shift+S+wheel
Set begin of filter K Temporal Offset T+wheel
Set end of filter L Spatial Offset X X+wheel
Set begin of render range I Spatial Offset Y Y+wheel
Set end of render range @]

Apply Brush mouse+leftMouse

Fit to Window Esc Subt. Brush mouse+rightMouse
Exact Pixel Scale Shift+E Pan Foreground Shift+leftMouse
Full Screen Shift+F Pan Background  Alt+leftMouse

Zoom wheel
Play/Stop Space|Down
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